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Archicad 8.0 
 
casa sampietro, "Mario Botta", 1979 
Pregassona / Tessin, via Arbostra 29 
 
This tutorial is based on a house built by Swiss Architect Mario Botta in the Italian part of Switzerland. 
The house is built on three floors. The ground floor is intended as the entrance, with some space for a car, 
some small rooms and an access to the stairwell. On the first floor we find the living room, the kitchen and 
another room, which can be used as a studio, working-room, etc. On the second floor there are the bedrooms 
and the bathroom. 
 
References to the project as well as pictures of the house can be found at: 
http://www.vitruvio.ch/arc/contemporary/1946-2000/casapregassona.htm  
http://www.uniroma3.it/sta/aaps/INT/G47/G47.HTM 
http://www.abcd.edu.cn/abord/Skewarch/project-7.htm 
http://home.t-online.de/home/friedl.werner/botta.htm 

Introduction to CAD 

Drawing in 2d 

CAD vs Hand drawing 
Drawing plans has been a necessity since the early days of Architecture. 
Drawings have 2 main purposes: 
1. Explain the project to the client, the authorities and the public. Design Stage. 
2. Pass on information from the designer to the builder and the manufacturer. Documentation Stage. 

Advantage of CAD. 
·  Precision. 
·  Editing. 
·  Re-use of information. 
·  Possibility of 3d drafting. 

Drawing in 3d 

3d for Presentation 
A 3d model can be used to produce photo real renderings and animations. The use of these images is 
limitless from Design Aids to Marketing. 

3d for documentation: The virtual building 
The latest software make more and more use of this technique where a 3d model of the building is entered in 
the computer and used throughout the process of designing and documenting the project. Floor plans, 
sections and elevations are not only extracted from the 3d model but they remain linked to it. When 
amendments are made to the model, the sections, plans and elevations are automatically up-dated.  
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Introduction to Archicad 

The Archicad Workplace 
3d modelling of Architectural Elements is what Archicad is all about. The building is mainly drawn in the Plan 
Window. Elevations and Sections are viewed and edited in the Section/Elevation Windows and Perspective 
and Renderings are viewed in the 3d Window. 

The Plan Window 

This window simultaneously plays two key roles: 
·  It displays a representation of the current project as a traditional architectural drawing; 
·  It is a 2D/3D-modelling environment in which all the designing and editing of the project are performed. 
Every Archicad Window contains a set of tools to Pan and Zoom in the current Window. 

The Pull down menus 
The Pull down menus are on the top of the screen; they pull down when we click on the menu heading. 
Use the File Pull down Menu to save the current drawing. 

The Tool Bar 

The Tool Bar contains the most commonly used functions also found in the Pull down Menus in a more 
accessible fashion. The Tool Bar can be moved around the screen and it can also be turned off. 

The Control Box 

The Control Box contains a number of highly sophisticated and often-used drawing aids in the form of icons. 
Available options include Relative Construction Methods, Cursor Snap and Special Point Snap controls, the 
Suspend Groups switch and the Magic Wand tool for conversion between element types. 
When maximized the Control Box also includes a Prompt Box displaying messages on what action is next 
expected from you. 
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The Tool Box 
 

The Toolbox on the left edge of the screen shows a variety of tools for selection, 3D 
construction. 2D drawing and visualization. 
The shape of the Tool Box can vary according to the settings chosen in the Pull down Menu 
Window -> Floating Palettes -> Palette Shapes. 
This is the place to look when you need to draw anything. It is easier if you understand the 
nature of the tools. You will notice that the tools are divided into categories, separated by small 
dividers. 

Selection Tools 
Use to select elements for editing or visualizing. 

3d Building Elements 
All you need to build a 3d model of a building. Keep in mind that these tools are named after 
their primary function and that you can use the roof tool to draw a ramp or the slab tool to draw 
a bench top, etc… 

2d Labelling Tools 
All the things you need to label a drawing, like text and dimensions. 

2d Set out Tools 
Drafting tools like lines, fill patterns, etc… 

Special Tools 
Tools that fall outside the 3d/2d categories like the Section/Elevation tool or the camera tool. 
 
 

 

The Info Box 
The Info Box floating palette gives you instant feedback on construction 
elements. It also allows you to reach the settings of any element and directly 
modify their parameters. 
The Info Box displays the icon of the active tool together with its current 
construction and geometry method, the current elevation or font size values, 
the name of the currently set library part, fill pattern, font or line type, the 
current fill pattern and layer name. 
When several elements are selected, the displayed information concerns the 
last selected element. 
If several elements overlap, successive clicking with the Checkmark cursor (in 
Arrow mode) will cycle through the selection markers of the available 
elements. 
 
 
 
 
 
 

The Coordinates Box 

In addition to allowing you to position the mouse accurately, the Coordinate Box enables you to enter numeric 
drawing coordinate for greater precision. 
The Coordinate Box also houses the Origin, Grid and Gravity control icons. 
Coordinates are designed to work in pairs. The X and Y are used when drawing in a rectangular area. The R 
(radius) and the A (angle) coordinates are used when you know the distance and the direction you are 
heading. 
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The button to the left of each pair makes a big difference to the way coordinates are used. Pressed in and the 
coordinates are relative to the last point you have drawn. Not pressed and the coordinates are relative to the 
project’s origin. Normally you will mostly work with both buttons pressed in. 
 
Coordinate input exercise 

·  Select the wall tool 
·  Click a point where you want to start drawing the wall from. This requires only one click and the 

release of the mouse button. 
·  Drag the mouse in approximately the correct position. 
·  Hold the Shift key down. This will constrain the angle to the horizontal or vertical axis (or a custom 

angle); Archicad indicates that the angle is locked by drawing a square around the A letter in the 
Coordinates Box. Keep the Shift key down. 

·  Hit the R key on your keyboard but don’t hold it down. This will lock the Radius value, and it is now 
highlighted. 

·  Release everything. 
·  You can now use the numbers on your keyboard to enter the length of the wall. 
·  Hit the Enter key to complete the operation. 
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Setting up a Project 

Working Units 
Options menu -> Preferences -> Working Units 
Set the Length Units to millimetres. 
Set the Angle Units to decimal degrees. 

Setting up stories 
Pull down Menu Options ->Stories -> Story Settings 
Set the followings: 
·  Name:  Ground Floor 
·  Elevation:  0 
·  Height to Next: 2750 

Creating Building Elements 

Drawing a Slab 

The Slab Tool 

Select the Slab Tool from the Toolbox. 
Click the Tool Settings from the Info Box or dbl click the Slab Tool. 
Set the following: 
·  Thickness:    200 
·  R.L. to Story and to Project Zero: 0 
·  Floor Plan Attributes:  Solid Line  
·  Section Attributes:   Structural Concrete 
·  Layer    Floor 
Set the material in the 3d Info Window. 
Top and bottom surface   Concrete 
Edge of slab     Render 
Select the appropriate Geometry Method from the Info Box. 
Draw the Ground Floor Slab 

 
 
 
 
 
 
Use the coordinates x and y to draw the 
slab. Starting from the Project Origin. 
When snapping to the project origin the 
cursor changes to a Checkmark.  
Save the file when the slab is finished. 
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The cursor 
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Zoom & Pan 
The last set of buttons in the display bar, Zoom In, Zoom Out, Pan, Fit in Window, Next View and Previous 
View, are basically the equivalents of the commands of the same name on the Display menu. Moreover, 
double-clicking on the Zoom In or Zoom Out icons results in a 200% magnification or a 50% reduction 
respectively. 

The 3d Window 

Activate the 3d Window 
Go to the 3d Window to check work in progress 

3d Window Settings 
Drop down Menu ->Image -> Hidden Lines or Shading or Wire Frame 

Activate the Plan Window 
Navigation between Windows, from the Window Menu or using Ctrl+3 Ctrl+2 
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Drawing a Wall 

The Wall Tool 

Select the Wall Tool from the Toolbox. 
Click the Tool Settings from the Info Box or dbl click the Wall Tool. 
Set the following: 
·  Floor Plan & Section Attributes: Solid Line. 
·  Fill:     Common Brick  
·  Height:    2550 
·  Thickness:    230 
·  R.L. to Story and to Project Zero: 0 
·  Layer    Exterior Wallsl 
·  Texture    Render 

Select the Construction Method from the Info Box. 
The wall construction methods in the Info Box and the Wall Settings dialog box determine where the physical 
thickness of the wall will be located with respect to the reference line. 
The reference line is used to connect walls precisely for clean intersections, and to establish hotspots and 
edges for selecting, moving or stretching walls. 
Choosing one of the wall orientation icons will establish a default orientation for the reference line, or change 
the orientation for any selected walls. 
You can modify the orientation of several walls with respect to their reference lines at the same time by 
selecting them and explicitly changing the construction method either in the Info Box 
or in the Wall Settings dialog box. 
·  Left  Follows the inside of the building when drawing counter clock-wise. If the size of the wall is 

later changed, the external dimensions of the building will change. 
·  Right Follows the outside of the building when drawing counter clock-wise. If the size of the wall is 

later changed, the external dimensions of the building will remain. 
·  Centre Recommended for internal walls. 

Select the Geometry Method from the Info Box. 
There are ten Geometry Methods available from the Info Box for drawing simple and special wall 
configurations. 
The icons in the top row allow you to draw straight walls: 
The Single Wall method produces one Wall element at a time. 
Each one is defined by drafting its Reference Line’s start point and end point. 
The PolyWall method produces a sequence of connected Wall elements with automatically coincident 
Reference Line end points. 
The first Wall is defined in the same way as a Single Wall, except that as you define its Reference Line 
endpoint, you also simultaneously define the next Wall’s Reference Line start point. Double-click to complete 
(or click the Control Box’ Cancel button to stop) drafting the last Wall element. 
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Draw the external walls. 
There is an easy way to draw a wall along a slab edge, using the Magic Wand. 
With the Wall tool active click the Magic Wand in the Control Box. You can also hold the space bar down 
instead, to bring up the magic wand. 
Move the cursor to the edge of the slab, when it changes into a hammer, click. The wall is drawn around the 
perimeter of the slab counter clockwise. Because the wall is drawn in a counter clockwise way, it is important 
that the Construction method is set correctly otherwise the walls are going to be drawn on the outside of the 
slab edge. 

 

The Magic Wand 

 
The Magic Wand tool traces the contours of existing elements in order to create new elements of other types. 
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Drawing the internal walls. 
Using the Wall tool and the same wall setting as for the external walls. Except for the layer, which should be 
Interior Walls. 
Steps needed include: 
·  Move the cursor to the project origin, the values for the x and y coordinates should display 0 
·  Lock the Y coordinate by using the Y key, Enter 7200 and press Enter. 
·  Draw the wall right across the house to a perpendicular point on the right hand sidewall. Watch the cursor 

change to the perpendicular cursor. 
·  The 2 vertical walls are simply drawn from the external corner on the external walls down; lock the 

direction and the distance (Shft+R) and Enter 8200 to finish the wall. You need to start from the external 
corner, otherwise the intersection will not clean properly, this is due to the position of the reference lines. 
Reference lines should match for the walls to intersect. 

 

Trim the internal walls. 
To trim away the unwanted bits of wall, simply hold the Ctrl key while clicking on the segment of wall to 
remove. 

Note : 
It may be necessary to turn off the visibility of the Slab to trim some wall as the cursor might select the slab 
instead of the wall. 
To turn off the slab use the Layer Setting (Ctrl+L) search the Floor layer and click the eye icon to close it. 
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Complete the ground floor walls. 
To trim away the remaining walls, draw a set of construction lines defining the position of wall ends and then 
trim the walls using the Ctrl + click method. 

When done delete all the construction lines. 
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Drawing Windows and Doors 

The Door and Window Tool  

Both windows and doors are library items, meaning that they are stored in libraries of objects, which can be 
used on many projects. 
Windows and doors can only be added to an Archicad project by placing them into an existing wall. They 
cannot be independently placed into a project. Once a window or door has been placed in a wall, it becomes 
an integral part of that wall and stays with the wall when it is moved or stretched. 
When you activate the Window or Door icon in the Toolbox and click on the reference line of a wall, the 
default door or window is inserted in the clicked wall. If you click somewhere else on the wall or simply on the 
worksheet (where the cursor does not assume its Mercedes form), Archicad will not allow you to position the 
door or window. 
Two types of openings are available in Archicad: 
·  Empty Holes: Often used to provide a quick sense of how an opening will look in a project. Empty holes 

are the simplest examples of windows and doors — they are shapes punched in a wall and have no 
details. 

·  Library Doors and Windows: Complex elements with a 3D model, a property description for the Bill of 
Materials and a 2D Symbol for the Floor Plan, specifying a variety of detailed information about the 
opening. 

Placing Doors and Windows into a Wall 
To produce detailed and realistic doors and windows, you will need to access items stored in libraries. 
Note: Your floor plan is saved with reference to the active library. Each time you open the drawing, the library 
has to be loaded or outside elements will not automatically appear. 
If you open a project and an alert informs you that items are missing from the active library, those items 
cannot 
be displayed on the worksheet, in the 3D Window. 
 

Adding the Windows and Doors to the Ground Floor 
Note: Only one window model was used throughout the project. You can find it in the Standard Archicad 
Library  inside: Object Library 6/ 1.BASIC LIBRARY 8/1.3 Windows 8/Wood Plastic Windows 8/Casement 
Windows 8 and it is called W1 Casement. 
Adjust the following settings: 
Frame Width = 19 
Frame Thickness = 90 
Sash Width = 19 
Sash Thickness = 90 
Change the “Horizontal and Vertical Grid number” to suit each particular window. 
The following windows need to be drawn on the Ground Floor: 
·  400 wide by 2100 high fixed window on each side of the stair well. 
·  1800 x 2100 fixed window in front of the Entrance Door. 
The following doors need to be inserted: 
·  820 x 2100 internal doors. 
·  1800 x 2100 entrance door with 2 sidelights and a 900 wide door. (Object Library 8/ 1.BASIC LIBRARY 

8/1.2 Doors 8/Wood Plastic Doors 8/Wood Entrance Door 8/D1 Entrance side2 
See the drawing on the next page for Doors and Windows positions. 
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The entrance needs to be closed off; in the original project this is done by a full glazing going right across the 
hallway; since Archicad does not allow to insert a window that is not inside a wall, it is necessary to draw a 
wall first. 
Draw a simple wall half way between the Entrance door and the wall end, then insert a fixed window with the 
following dimensions: 2140 wide by 2550 high. 
Check in the 3d Window that your project looks like the one in the next picture. 
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Things to check at this stage: 
There should be no duplicates. You can tell if you have duplicate walls when the 3d view is not clean (lines 
across walls, walls not hiding properly); also if a door or a window is not displayed clearly, chances are that 
the wall has been doubled, or even the door/window itself has been doubled. 
In the plan view, all the wall intersections should be cleaned. If none of the intersections are cleaned, check 
under the Options menu in Display Options, that the first option “Wall and Beam Intersections” is set to “Yes”. 
If only a few intersections are not cleaned, check that the reference lines of both walls are connecting 
precisely. 
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Elevations, Sections and Perspectives 

Creating Elevations 
Section/Elevation windows are generated through the placement of section lines on the Floor Plan with the 
Section/Elevation tool. 

 
Once a section line has been defined, the name of the corresponding Section/Elevation appears in the 
corresponding hierarchical menu in the Window menu and can be opened by choosing its name. 
To create an elevation; follow these steps: 
·  Zoom out until you can see the entire floor plan. 
·  Click the Section/Elevation tool. 
·  Select the first node of the elevation line outside the bottom left corner of the floor plan. 
·  Hold the Shift key down to select the second node of the elevation line in a straight line outside the bottom 

right corner of the plan. 
·  When the first 2 nodes have been selected, click the OK button in the Control Box. 
·  Choose the direction for the elevation by clicking a point in the centre of the floor plan. 
The elevation is automatically created, you can view it in it’s own window by using the Window Pull down 
menu and selecting the Elevation under Sections/Elevations 

As the model is created, the elevations will automatically be up-dated. 
Create the other 4 elevations using the same process. 
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Insert Objects in the Model 

The Object Tool 

The Object tool is used to place and edit Object type library parts into the project, which add a floor plan 
symbol to the plan, appear in Sections/Elevations and 3D visualizations (if they have a 3D description). 

The Object Settings 
The number of settings that can be changed depends on the type of object being added to the model. These 
can range from very simple pieces of furniture to very complex elements. 
The Australian version of Archicad comes with a special Australian library on top of the standard Archicad 
library. Double-click the Object Tool and spend some time browsing all the available objects in the 2 libraries. 
The next image shows a bench inserted outside the entry window. That bench is the Bamboo Couch found in 
the basic library under furnishing and in Couches and Sofas. 
The original size of the bench has been changed to fit in the available space in between the 2 walls. With that 
sort of object, the size can be changed either by dragging one corner of the object after insertion or preferably 
by changing the length parameter in the Object Setting dialog. 
Using the same method, you can also insert the stairs. With the stairs it is important that you check the floor to 
floor height otherwise the sections are going to be wrong. 
The stairs used in the example come from the Archicad Stairs Library  – Basic Library 8 – 1.4 Building 
Structures 8 – Stairs 8 – Stairs Simple 8 and is called Stairs U Shape. 
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Creating a Section 
A section is created in exactly the same way as an elevation, except that the section line is taken through the 
building. 
The following image shows a section taken through the stairs. 

 
 
It is a good idea to create sections and elevations early in the project as they allow to easily check that the 3d 
information entered for the project is correct. 
 

Naming Elevations and Sections 
 
As you create sections and elevations, Archicad assigns a number to each one of them. It is much easier to 
remember and found them if you rename them using more meaningful names. 
To rename an Elevations: 
·  Go to the plan window. 
·  Select the elevation line. 
·  Activate the tool settings (Ctrl T) 
·  In the name Field, Enter a name, for instance South Elevation. This will not change the elevation symbol in 

the plan view but will change the name of the Elevation Window and its display in the list of 
Elevation/Section. 

·  In the Reference ID field you can choose to use a different ID system like for instance letters instead of 
numbers. This will change the display in the floor plan window. 

 

� �� �� �� � ���� � � � � � 	 
� � � � � 	 
� � � � � 	 
� � � � � 	 
 ���� � �� �� �� � 
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Creating the upper floors. 
Archicad keeps all the floors in the same file, along with the Elevations and the Sections. 
To create other floors, activate the Story Settings by pressing Ctrl + 7 or from the Pulldown Menu Options 
under Stories -> Story Settings. 
Select the Ground Floor and click on Insert Above to create the First Floor. 
Do the same for the Second Floor and the Roof 

When done, select the Ground Floor again and then click on Copy All, this will select all the elements inserted 
on the Ground Floor; then select First Floor and click on Paste Selected Types. That operation will copy all 
the walls, doors, windows, stairs, etc… found on the Ground Floor and insert them on the First Floor. All there 
is then left to do is edit the new First Floor by erasing unwanted elements and inserting new ones. 
From now on you will need to pay attention as to which floor you are currently working on. The name off the 
current floor appears in the title of the Floor Plan Window. 
By holding the Ctrl key down and pressing 6 you will move up one floor, if you press 5 you will move down 
one floor. 
Active the first floor and then delete all the doors. 

Deleting Doors 
To delete or erase elements you need to select them and then press the Delete key. 
To select a door; click on one of its hot spot with the Arrow tool. 
To select all the doors on the current floor, click the Door Tool and then press Ctrl + A. 

Deleting Windows 
One window needs to be deleted, the one across the hall facing the front door. 
The other windows will be edited. 
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Editing Windows 
The windows on each side of the Stairs need to be changed into wider windows. Increase their width to 
1600mm and change the number of vertical panes to 5. 
 
 
The first floor plan should now look something like the next picture. 
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Modifying the slab 
A slab is an element known as a polygon in Archicad. Polygons can be edited with a specific set of tools. 
These tools provide the following options: 
·  Add or modify a polygon edge. 
·  Add or move a polygon summit. 
To modify an edge: 
Select the slab with the arrow tool or while holding the shift key. 
Make sure the slab tool is active. 

Click on the edge of the polygon that you want to edit. This will activate the following slab editing tools. 
 
The first tool on the left lets you add a corner (summit) to the polygon. 
The next one lets you curve the selected edge. 
The third one is used to move the selected edge; the rest of the polygon will be adjusted. 
The last 2 tools let you add or subtract a portion to a polygon. 
 
If you click on a corner of the polygon a different set of tools is made available. 

 
The first tool on the left lets you move a corner (summit) of the polygon. 
The next one lets you curve the selected corner. 
The third one is used to stretch the entire polygon.. 
The last 2 tools let you add or subtract a portion to a polygon. 
Using a combination of the 2 methods; modify the first floor slab as per the next picture. 
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Completing the First Floor 
The next elements need to be edited to complete the first floor: 
·  The side walls need to be changed to one continuous wall on each side; to do this delete one part of the 

wall on one side of the opening and then extend the remaining wall. Select the wall to extend, make sure 
the Wall Tool is active, hold the Ctrl key while clicking on the wall you want to extend to. 

·  New 90 thick stud walls need to be drawn inside the plan. 
·  An internal door needs to be inserted into the bathroom. 
·  The front walls need to be closed in at a 45° angle near the front of the house; these will be turned into 

glazing later 

 
. 

Add the remaining windows to the First Floor 
The windows on the sidewalls are 1775 wide and 2550 high. 
The windows at 45° are 1670 wide and 2550 high. 
When inserting these windows; it is almost impossible to get them in the right place; the best way is to place 
them in the wall and then to move them. Because this will put them partly outside the wall, Archicad will 
display an error message and ask if you still want to draw the Window. Click on Yes to accept the placement 
anyway. 
To move the windows into position, first select the window with the arrow tool, then hit Ctrl + D, select a base 
point and the point to drag it to. 
Complete the first floor plan by cutting the slab around the stairs. 
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The next picture shows the first floor slab with the cut out for the stairs. 

 



QUT School of Design and Built Environment  Introduction 
CRICOS No 00213J   To Archicad 8.0 

Page 24  S. Gard 
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Completing the Second Floor 

Copying Elements from one floor to another 
There are 2 ways for copying elements between stories: 
·  Use the Stories Setting (Ctrl + 7) 
·  Use Copy (Ctrl + C) and Paste (Ctrl + V). First Choose the objects on one floor and hit Ctrl + C before 

moving to the other floor Ctrl + 6 to move up or Ctrl + 5 to move down. When on the correct floor hit Ctrl + 
V to paste. 

The second floor is best created with the same slab as the First Floor, the same wall as the Ground Floor 
while the stairs should not be copied. 
 

 
Complete the floor plan with doors and windows, feel free to change the design and to experiment with 
different window/door types.
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Completing the Roof 
The house is covered with a flat roof, while the front recessed has a pitched roof over. Start first by drawing 
the slab. Copy an existing slab from another floor and then modify it to suit. 

 
Then add a parapet wall 500mm high. 
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Add the following objects to the roof. 
Pay particular attention to the layer on which the object are inserted as well as the object material. 
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Creating a Roof 
In the following steps we will: 
·  Draw a hip roof. 
·  Change the hip roof into a gable roof 

The Roof Tool 

 
·  Double click the Roof Tool to activate the Roof Settings Dialog 
Adjust the following settings: 

·  The height to Story 4. This is the height from the 
Roof Slab to the springing point of the roof. The 
springing point will be selected to draw the roof, 
typically this is a point on the wall top plate; in this 
case it will be a point on the edge of the parapet 
wall. Archicad refers to a pivot line when defining 
the springing point. You will later move the roof in 
its final position on top of the trusses, so the 
distance you enter here only needs to be 
approximate. 

·  The height to projection zero is automatically 
adjusted according to the height to Story 4. 

·  The slope of the roof has to match the slope of the 
trusses. 

·  The thickness is the total thickness of the roof in 
section. 

 
 
 
 
 
 
 
 
 
 
 

The Roof Geometry 
The Roof tool has six geometry methods, allowing you to create both simple and complex roof shapes. 
·  Polygon method: Creates a polygon shaped roof. 
·  Rectangle method: Creates an orthogonal rectangular roof. 
·  Rotated Rectangle method: Similar to the Rectangle method, but you can define the pivot line at any 

angle. 
·  Polyroof method: Creates equally sloped roofs on any polygonal or curved base 
·  Dome method: Creates a semispherical dome-shaped roof. 
·  Barrel Vaulted method: This method allows you to model any form of roof structure, including the most 

complex ones. 
The best method for our roof is the Polyroof method. 
Follow these steps: 
·  Enter First Node of Roof Pivot Line. Select the bottom left corner of the first column. 
·  Enter Next Node of Roof Pivot Line. Select the top left corner of the 4th Column. 
·  Enter Next Node of Roof Pivot Line; Keep selecting points on the corners of the columns until you have 

define a rectangle. To close the rectangle you can either select the first point again or double click the last 
point. 
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The following dialog is displayed: 

 
Double check the slope, the roof thickness and enter an overhang. 
The levels are used to create more complex roof, for instance a roof linked to a verandah roof. 
Click OK when done, the following roof is drawn. 

 
Change the hip roof into a gable roof 
·  Using the arrow tool, select the front and back Hips and delete them. 
·  Select one of the remaining Hip and activate the Roof Tool. 
·  Click the end point of the ridge. 
·  Select the first tool (Move Node) and move the point to a point in line with the bottom left corner of the 

roof.  
·  Repeat the process until the entire roof is turned into a Gable Roof. 
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Then you will need to position the roof on top of the trusses, this is best achieved from the south elevation 
view. 
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Adding balustrade. 
Using the object tools, insert balustrades in the model. 
The following areas need a balustrade: 
·  The front of the landing on the first and second floor. 
·  The balcony on the second floor. 
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Creating a perspective 

Defining a position for the camera 
Make sure you maximize the view in the PLAN WINDOW (Ctrl+’). 
Zoom out a couple of times to allow space around the building. 
From the Image Pull Down menu; select 3d Projection Settings. 
If the Parallel Projection Settings box appears, click on Perspective Settings to jump to the Perspective 
Settings dialog. 
The left pane displays a small image of the floor plan. Use it to position a camera, Ctrl+Click in the window to 
position the camera and then Shift+Click to position a target 
Enter the camera location by clicking a point outside the house where you would be standing to take a picture. 
Enter the projection target by clicking a point roughly in the center of the house. 
A diagram representing a camera, a cone and the sun appears on the drawing. You can now move either by 
clicking and dragging with the mouse. 
Make sure that Camera Z position and the Target Z position are set in a way that the camera is not aiming 
above or below the building. 
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Adjusting the camera view. 

Whether you can use the controls in the 3d window to adjust the view, will depend on the amount of memory 
you have and the speed of your computer. 
Try to experiment with the Editing Motion functions. 
·  Walk; by clicking and dragging the mouse towards the bottom of the screen, you will walk away from the 

model, increasing the distance between the target and the camera. By dragging the mouse towards the 
top of the screen you will move closer to the house and by dragging left or right you will move in those 
directions. 
The motion mode has a greater effect when moving Left or Right, if Camera/Model Axes is selected, both 
the camera and the target are moving and the house will eventually disappear from the image. If Target 
Lock/Display Axes is selected, only the camera is moving, aiming at the same point while doing so. 

·  Lateral Move; dragging the mouse up or down the screen moves the camera up or down, moving left or 
right is similar to Walk 

·  Turn; Left or Right, turns around the target, up and down 
·  The camera cone angle affects the perspective. The larger the cone the more the perspective is distorted.  
 



QUT School of Design and Built Environment  Introduction 
CRICOS No 00213J   To Archicad 8.0 

Page 34  S. Gard 

More advanced modelling. 
The project by Mario Botta includes a curved stair well and a window above the stairs on the last floor. 
To achieve this it’s simply a matter of deleting the walls around the landing. 

Then Replace the U shape stairs by 2 straight stairs and draw a landing with a curved edge using the slab 
tool make sure the distance from the floor is exactly half the floor to floor distance. 
Modify the floor slab to give it a curve around the stairs. 
Draw a curve wall around it. 
On the second floor, the curved walls you have just created need to be changed from full floor height to 1800 
high, this is to allow for a window to be inserted above the stairs, in line with the façade of the house. 
In order to insert that window, you need to create a wall that spans across the stair well, since you don’t want 
to see that wall in the second floor plan, it’s best to draw it on the roof plan. 
When the wall is drawn, you can insert a window of the full length of the wall. 
This is the final rear elevation 
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The front elevation 
The front window is normally a window going from the ground floor to just under the roof, since Archicad 
creates each floor separately a window cannot span across many floors. 
To create the illusion of the window going all the way to the roof, change its height on the ground and first 
floor making it 2775. 
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Creating Drawing Elements 

Add Fill Pattern. 
Fill pattern or hatching are attached automatically to certain type of object like walls and roofs, the fill pattern 
for a wall is displayed whenever the wall is cut as in a floor plan or a section. 

The Fill Tool is useful to display areas hatched like for instance a tiled floor.  
To add a fill pattern, double click the Fill Tool and then select the type of fill you want to draw. 
Take a look at the Construction Method in the Info Box it allows to place the fill at it’s predefined angle or at 
any angle you wish. If you choose the angled method, you will first need to draw a line indicating the angle for 
the fill. 

 
The geometry methods, include: 
·  A polygon method, allowing to define every edge of the polygon; this is useful when drawing a fill around 

a non-square room. 
·  A rectangle method; makes it easier to draw a fill in a square room by selecting only 2 corners of the 

room. 
·  An angled rectangle. 
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Add Dimensions and Text 

The Dimensions Tool 

The Dimensions Tool is used to place dimensions in the floor plan window as well as in the section/elevation 
window. 
Double click the Dimensions Tool to activate the Settings Dialog. 
 
The first option lets you define which font to use to write the dimension text. Just underneath you can set the 
text height and the position of the text in reference to the dimension line. 
You can then select a colour for each element of a dimension; the text, the lines and the arrows. 
On the right you can select the dimension type; the first one is the most common for a floor plan while the 
running dimensions are more useful in a section. 
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Placing Dimensions 
Dimensions will be attached to the element used while placing the dimensions; this means that if you have 
selected the corner of a wall to draw the dimension, it will be attached to that wall; if you modify the wall, the 
dimensions will be modified too reflecting the changes you have made. 
One common problem with dimensions is bad selection, for instance clicking to the corner of the slab instead 
of the wall; this of course will have a dramatic effect if the wall is changed later on as the changes will not be 
reflected in the dimensions. Therefore it is recommended to turn off layers on which fill patterns and slabs 
have been drawn prior to dimensions walls. 
Place the first overall dimension by selecting one corner of the house and then the next corner. The arrow 
should change into a check mark when you are precisely on the corner of the wall, once the first point is 
selected, the cursor takes the shape of the Empty Pencil; it should turn to a black pencil when you are 
precisely on the next point. Make sure the Geometry Method is set for what you want to do, for instance 
horizontal or vertical dimension. Then double click anywhere on the screen, this will indicate that all the points 
have been selected; the next click with the Hammer cursor will position the dimension line. 

Editing Dimensions 
Most of the time the edition of the dimensions is done by changing the element the dimension is attached to. 
However you can add or remove dimensions from a string of dimensions. 
Copy the first dimension that you have drawn and place the copy just below the first one; make sure you hold 
the shift key down to copy in a straight line. 
With the Arrow Tool select the dimension line closest to the building and while holding the Ctrl key down, click 
new points along the building. Every point you select is added to the dimension line. 
 

If a text needs to be moved, click its hot spot with the arrow tool then drag it into position; the hot spot is on 
the bottom left corner of the text. 
To delete one dimension, click its hot spot, on the marker and then press Delete. 
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The Text Tool 

The Text Tool is used to place strings of text in the drawing, typically, annotation and titles. 

Placing Text 
Double click the Text Tool to activate the Settings Dialog. 

 
Choose a Font, a style like Plain, Bold or Italic and a justification; set a text height in mm. The options under 
leading define a spacing between lines of a multi lines text. 
When you are done click OK. 
To place the text in the drawing, you have 2 options: 
1. Draw a fixed width text block by selecting a point, Archicad expects you to then define a rectangle by 

clicking a second point. The text will then be contain within the width of that rectangle, creating new lines 
as they are needed. 

2. Double click the text insertion position; this will allow you to keep typing along the same line until you 
press return to create a new line. 

When you are done, click a point outside the text area to finish. 

Editing Text 
To change things like: the text height, the font or the spacing between lines; select the text with the Arrow 
Tool and activate the Settings Dialog (Ctrl T). 
To change the content of a line of text, activate the Text Tool and click on an existing text while holding the 
Shift key, then click inside the text to do the changes. 
 



QUT School of Design and Built Environment  Introduction 
CRICOS No 00213J   To Archicad 8.0 

Page i  S. Gard 

Table of content 
Archicad 8.0......................................................................................................................................................... 1 
Introduction to CAD ............................................................................................................................................. 1 
Drawing in 2d....................................................................................................................................................... 1 
CAD vs Hand drawing ......................................................................................................................................... 1 
Advantage of CAD. .............................................................................................................................................. 1 
Drawing in 3d....................................................................................................................................................... 1 
3d for Presentation .............................................................................................................................................. 1 
3d for documentation: The virtual building........................................................................................................... 1 
Introduction to Archicad ....................................................................................................................................... 2 
The Archicad Workplace...................................................................................................................................... 2 
The Plan Window................................................................................................................................................. 2 
The Pull down menus .......................................................................................................................................... 2 
The Tool Bar ........................................................................................................................................................ 2 
The Control Box................................................................................................................................................... 2 
The Tool Box ....................................................................................................................................................... 3 
Selection Tools .................................................................................................................................................... 3 
3d Building Elements ........................................................................................................................................... 3 
2d Labelling Tools................................................................................................................................................ 3 
2d Set out Tools................................................................................................................................................... 3 
Special Tools ....................................................................................................................................................... 3 
The Info Box ........................................................................................................................................................ 3 
The Coordinates Box ........................................................................................................................................... 3 
Setting up a Project ............................................................................................................................................. 5 
Working Units ...................................................................................................................................................... 5 
Setting up stories ................................................................................................................................................. 5 
Creating Building Elements ................................................................................................................................. 5 
Drawing a Slab .................................................................................................................................................... 5 
The Slab Tool ...................................................................................................................................................... 5 
Select the Slab Tool from the Toolbox. ............................................................................................................... 5 
The cursor............................................................................................................................................................ 6 
Zoom & Pan......................................................................................................................................................... 7 
The 3d Window.................................................................................................................................................... 7 
Activate the 3d Window ....................................................................................................................................... 7 
3d Window Settings ............................................................................................................................................. 7 
Activate the Plan Window.................................................................................................................................... 7 
Drawing a Wall..................................................................................................................................................... 8 
The Wall Tool....................................................................................................................................................... 8 
Select the Wall Tool from the Toolbox................................................................................................................. 8 
Draw the external walls........................................................................................................................................ 9 
The Magic Wand.................................................................................................................................................. 9 
Drawing the internal walls.................................................................................................................................. 10 
Complete the ground floor walls. ....................................................................................................................... 11 
Drawing Windows and Doors ............................................................................................................................ 12 
The Door and Window Tool ............................................................................................................................... 12 
Placing Doors and Windows into a Wall............................................................................................................ 12 
Adding the Windows and Doors to the Ground Floor........................................................................................ 12 
Things to check at this stage: ............................................................................................................................ 14 
Elevations, Sections and Perspectives.............................................................................................................. 15 
Creating Elevations............................................................................................................................................ 15 
Insert Objects in the Model ................................................................................................................................ 17 
The Object Tool ................................................................................................................................................. 17 
The Object Settings ........................................................................................................................................... 17 
Creating a Section ............................................................................................................................................. 18 
Naming Elevations and Sections....................................................................................................................... 18 
Creating the upper floors. .................................................................................................................................. 19 
Deleting Doors ................................................................................................................................................... 19 
Deleting Windows .............................................................................................................................................. 19 
Editing Windows ................................................................................................................................................ 20 
Modifying the slab.............................................................................................................................................. 20 



QUT School of Design and Built Environment  Introduction 
CRICOS No 00213J   To Archicad 8.0 

Page ii  S. Gard 

Modifying the slab.............................................................................................................................................. 21 
Completing the First Floor ................................................................................................................................. 21 
Completing the First Floor ................................................................................................................................. 22 
Add the remaining windows to the First Floor ................................................................................................... 22 
Completing the Second Floor ............................................................................................................................ 25 
Copying Elements from one floor to another ..................................................................................................... 25 
Completing the Roof .......................................................................................................................................... 26 
Creating a Roof.................................................................................................................................................. 28 
The Roof Tool .................................................................................................................................................... 28 
The Roof Geometry ........................................................................................................................................... 28 
Adding balustrade.............................................................................................................................................. 31 
Creating a perspective....................................................................................................................................... 32 
Defining a position for the camera..................................................................................................................... 32 
Adjusting the camera view................................................................................................................................. 32 
Adjusting the camera view................................................................................................................................. 33 
More advanced modelling.................................................................................................................................. 34 
The front elevation ............................................................................................................................................. 35 
Creating Drawing Elements ............................................................................................................................... 36 
Add Fill Pattern. ................................................................................................................................................. 36 
Add Dimensions and Text.................................................................................................................................. 37 
Placing Dimensions ........................................................................................................................................... 37 
Placing Dimensions ........................................................................................................................................... 38 
Editing Dimensions ............................................................................................................................................ 38 
The Text Tool..................................................................................................................................................... 40 
Placing Text ....................................................................................................................................................... 40 
Editing Text ........................................................................................................................................................ 40 
Table of content .................................................................................................................................................... i 

 


